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1 ABOUT THIS DOCUMENT 

 

1.1 About SkyWeb 
 
To access the SkyWeb portal go to SkyTrac System’s main web page at www.skytrac.ca.   
  

 
 

 
 
 
If the user wishes to save a link to SkyWeb as a favorite, they should save the path 
http://skyweb.skytrac.ca in their favorites. Using either of these two methods will ensure that 
they are taken to an active SkyWeb server. 
 
Minimum Browser requirements are Internet Explorer 8+ and Firefox 3.5+. A broadband 
internet connection is recommended. The user can choose to select either the standard (http) 
security or enhanced (https) security. 
 
SkyWeb has seven components: 
 

 Flight Following – the flight following & mapping software 
 Account Management – SkyWeb account administration 
 Administration – configure alert notifications, cockpit interface configuration, 

geographic references and hardware profiles. 
 Hardware Management – asset activation and configuration 
 Flight Data Monitoring – Manage and report on aircraft FDM data. 
 Reports – view daily/yearly asset usage and historical invoices 
 Duty Hours – Manage and report on pilot duty hours. 
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1.2 Purpose 
 
The purpose of this document is to provide instructions on how to use the features of the 
Flight Following module of the SkyWeb Portal.  Instructions on how to use the Account 
Management, Administration, Hardware Management, Flight Data Monitoring, Comms Traffic 
Reports and Duty Hours components can be found in the SkyWeb Administrator Guide. 
 
 
 
1.3 Definitions, Acronyms, Abbreviations 
 

Acronym Description 
STS SkyTrac Systems 
HMC Hardware Management Console 
PM Program Manager 
DVI Dispatch Voice Interface 
CDP Cockpit Display Panel 
CDP/DVI Combination of DVI and CDP 
HRD High resolution data 

  
 
 
 
 
  



SkyTrac Systems Ltd. 

SkyWeb User Guide v 03.20 (DOC1838)  Page 7 of 79 

Restricted Proprietary and Confidential Information 

2 GENERAL 

 

2.1 User Account Roles 
 
The User Accounts, and the Roles each user has, are configured in the Account Management 
component of SkyWeb by the Program Manager. 
 

2.1.1 Flight Following: Basic Role 
 
This is a standard user role that only has access to current flight information. Some of the 
options listed in this manual will not be available for this role. 
 

2.1.2 Flight Following: Full Access Role 
 
The Full Access role will have access to the same features as the Basic role plus: 
 

 SkyMail 
 Previous flight information  
 FlightBar: Status Tab  
 FlightBar: Flight Tab 
 FlightBar: Log Tab 
 Create/Edit Georeferences 

 

2.1.3 Weather 
 
The Program Manager can add the ‘Weather Role’ to a user account. This is a paid service 
and therefore not all users will have been given access to it. 
 
The user can be given access to weather overlays for:  

 Canada  
 US  
 Europe  

 
Access to these can be given in any combination (i.e. individual, some or all). 
 

 
DISCLAIMER 

Weather data is provided on an “as-is” basis, exclusively for information 
purposes.  SkyTrac and Schneider Electric make no claims as to the accuracy, 
completeness, or currency of any Information on this site and shall not be held 
liable for errors, omissions, delays or any damages, losses or injuries related 
to the use of this information. 
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2.2 Accessing SkyWeb 
 

2.2.1 Logging In 
 
SkyWeb is accessed from the SkyTrac Systems website www.skytrac.ca. Click on the 
SkyWeb link in the upper right corner of the page to open the login page.  Alternatively, you 
may enter the path http://skyweb.skytrac.ca.  Enter the username and password as provided 
by your local SkyWeb Program Manager. 
 

 
WARNING:  
User accounts are restricted to a single login. Only one user may use the 
account at a time. Failure to comply may cause a forced logout! 
 

 
 
Users with multiple privileges within SkyWeb will see the Main Menu page 
first. If that is the case then they must click the ‘Flight Following’ button to 
access the flight following module of SkyWeb. Clicking on the Flight 
Following button will cause SkyWeb to load and the ‘Load Data’ dialog box 
will be displayed. 
 

 
 
 

2.2.2 Load Data 
 
This provides the user with the ability to select which data they wish to see. They have the 
option to select all aircraft, specific aircraft or just a single aircraft. They can select to load 
units either by the Call Sign, Unit, Reg # or IMEI #.  
 
Those users that have full access can also select the amount of data to load.  
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2.2.2.1 All 
 
This will load every aircraft 
in the user’s account.  If 
there are many aircraft, they 
may notice a slight delay in 
loading. 
 

 
 
 
 
 
 
 
 
 
 
 

 
 

2.2.2.2 Selected 
 
If the user wishes to select a number of 
specific aircraft then they must click on 
the ‘Select...’ option.  This will cause the 
‘Select Resource(s)’ dialog box to be 
displayed (see below). To select 
multiple aircraft they must hold the 
CTRL key down and click on each 
resource they require in the ‘Available’ 
area: 
 

 
 
 
 

 

By clicking the  (Add) button any resources currently selected will be placed in the 
‘Selected’ area.  Only aircraft that are in the ‘Selected’ area will be displayed in the Status 
Tab of the FlightBar. To add the entire list of ‘Available’ aircraft to the ‘Selected’ area use the 

 (Group Add) button. 
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2.2.2.3 Single 
 
Click the ‘Single’ radio button to enable the drop-down box in order to select a single aircraft 
to display on the map. 
 

 
 
The user can select a number of days or flights to view, depending on how much historical 
data is needed to be seen. The smaller amount of data selected, the faster the Flight Following 
Interface will load. 
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If the user has been given the ‘Historical Data’ privilege by the Program Manager in the 
Account Management section they will be able to load up to a 31 day period of historical data, 
as long as that period is within the last year. They will have to change the ‘Current’ option in 
the drop-down menu to ‘Historical’  
 

 
 
 
If the user account has Iridium handsets then the following option will be available. 
 

 
 
Using the calendars the user can specify the date period they wish to load. They also have 
the option to export the data to MS Excel by using the ‘Export’ button. 
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The user can specify how they wish to delimit the data and which additional items to include. 
The data will then be exported to MS Excel to enable the user to manipulate it as they wish. 
 

If the Show at launch checkbox  is unchecked, the next time Flight Following 
is selected from the main menu, the Flight Following map will open automatically, displaying 
the same Resourcse and time settings from the previous session.   
 
If the user needs to change any of the resources or other settings, they can simply select 
‘Reload Data…’ from the Flight Following Menu bar. 
 
 

2.2.3 Logging Out 
 
In order to log out, the user can either click the File > Logout menu option, or click on 
the doorway icon in the upper right corner of the page (if available). 
 
 
 
Note: 
If the SkyWeb window is closed without using one of the logout options, the  
Session will remain active for five minutes before that account can be accessed again. 
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2.3 Areas of the SkyWeb Window 
 
Once the user has selected the data to load they will be presented with the SkyWeb window. 
This window consists of three main areas: 
 

 The Toolbar/Menus 
 The Main Map 
 The FlightBar 

 
 

 
  
 
2.4 Navigating the Map 
 
There are a number of ways to navigate around the map: 
 

 The navigation tools in the Dashboard (see Section 3.2.6). 
 The map can be dragged to the required location by clicking on it with the mouse and 

then holding the mouse button down whilst dragging it across the map. The map will 
then move with the mouse. 
Clicking and dragging the rectangle in the Overview Map (see Section 3.2.7)  
 
 

2.5 Latitude & Longitude 
 

 
 
Located in the toolbar is a Latitude and Longitude indicator. As the mouse is moved around 
the map the latitude and longitude will change to give its current location. 

Toolbar/Menus 

Main Map 
 

FlightBar 
 



SkyTrac Systems Ltd. 

SkyWeb User Guide v 03.20 (DOC1838)  Page 14 of 79 

Restricted Proprietary and Confidential Information 

2.6 2D/3D View 
 
By selecting the relevant option in the toolbar; Microsoft’s mapping can be displayed in either 
a two or three dimensional view. In the 3D view, additional tilt buttons will be available in the 
Dashboard (see Section 3.2.6). The first time the 3D view is selected, the user may be 
required to download and install Microsoft’s 3D add-on. 
 
 
2.7 Mapping 
 
From the drop-down menu the user can select to use either Google or Microsoft’s mapping.  
 

 
 
If these options have not been used before, the user may be requested to download additional 
plug-ins. 
 
 
2.8 Zoom/Scale 
 
The user can zoom in and out using the mouse wheel or the (+) and (-) 
icons on the dashboard. To zoom directly in to an area of interest the user 
can double-click on that area of the map. 
 
The Scale of the map can be selected directly from the toolbar if required: 
 
 
The current scale is indicated in the bottom right corner of the 
map. This scale reading will change as the user zooms in or out.  
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2.9 Colour Codes 
 
SkyWeb uses colour codes to provide the user with a quick guide to the status of an aircraft: 
 

Icon Colour Remarks 

 

Black 
Aircraft powered down on the ground at its 
last known location. 

 

Brown 
Powered-up on the ground (if skids/wheels 
switch wired and configured) 

  

Purple 
On the ground and in Mission (if mission 
switch wired and configured) 

 

Blue In flight 

 

Pink In flight and in Mission  

 

Green Aircraft is on a voice call 
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Red Emergency 

 

Orange Reports are overdue 

 

Yellow 

Two shades of yellow highlighting are used 

to indicate a Geofence   or 

FlightWatch violation   

 

Encryption 

A padlock symbol is added to the standard 
icon when the asset is sending encrypted 
data.  A padlock icon also appears in the 
FlightBar 

 
These colours are used in the aircraft caption box, the preview box, the status box, the aircraft 
icons and in the FlightBar. 
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3 TOOLBAR MENU ITEMS 

 
3.1 File Menu 

 
 
Some menu items also have buttons associated with them. 
 
Menu Sub-Menu    Button Remarks 

File SkyMail… 
 

Allows for text messaging to and from aircraft.  
Only available to users that have Full Access. 
See Section 5 for details 

 Save Settings  
Save current interface configuration settings 
without exiting 

 Reload Data…  
Brings up the Load Data dialog (Section 2.2.2) 
so the user can change resources and amount 
of data viewed 

 Print Log…  
Opens a new web browser window with the 
information exactly as displayed in the active 
FlightBar tab 

 Home 
 

Takes users with only Flight Following access 
to the Load Data dialog. Users with multiple 
SkyWeb privileges will be taken to the Main 
Menu 

 Logout Logs out the user as per Section 2.2.3 

 
 
3.2 View Menu 
 
The View Menu shows or hides 
information overlays on the map. These 
information boxes are described below.  
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3.2.1 Status 
 
Selecting this option will cause the status of the selected flights to be displayed in tabulated 
form in the top right corner of the screen.  
 

 
 
The ‘Overdue’ field will show if there is a delay in receiving a report that exceeds the setting 
the user has configured for Alarms, see Section 3.5.1. The ‘Inactive’ field represents units that 
have been assigned to the user account but have not yet been activated. 
 

3.2.2 Events 
 
Selecting this option will cause new flight events to be 
displayed near the top right corner of the screen as they 
are received. 
 
 
 

3.2.3 Updates 
 
Selecting this option will cause new incoming position reports to be 
displayed (near the top right corner of the screen) as they are 
received. They will be colour coded using the same colour scheme 
as the position log. 
 
 
 

3.2.4 Find Box 
 
The Find Box enables a user to search for a specific location, address or business on the 
map. If selected it will be displayed at the bottom of the SkyWeb window. 
 

 
 

3.2.5 Crosshairs 
 
Selecting this option causes crosshairs to appear at the centre of the 
current map view: 
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3.2.6 Dashboard 
 
The dashboard provides alternate ways to navigate the map and the ability to change map 
view: 
 

Microsoft Dashboard 
 

 
 
 

Google Dashboard 
 

 
 

3.2.6.1 Map Navigation 
 
Selecting an arrowhead with the mouse will cause the map to move in that 
direction. This can also be achieved by clicking on the map itself and dragging 
it to the required location. For larger shifts it is easier to use the Overview Map 
(see Section 3.2.7).  
 
The Google navigation arrows work in similar way with the addition of the 
center square of arrowheads, which (if clicked) will take the user back to the 
last result.   
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3.2.6.2 Zoom Controls 
 
If the user clicks and holds on the relevant zoom control in the 
dashboard, the map will zoom in (or out) until the button is released.  
 
 
 
The Google zoom control (far right) has the addition of a slider that can be dragged 
to increase or decrease the zoom level. 
 
 
 
 

3.2.6.3 Microsoft 3D Controls 
 
3.2.6.3.1 Camera Rotation 
 
In ‘Birds Eye’ view (only available in 2D mode) the user will also see the addition of 
the camera rotation buttons. These will enable the user to rotate the image in the 
relevant direction: 
 
3.2.6.3.2 Tilt Controls 
 
Another addition to the Dashboard is the tilt controls. These become visible when 
the 3D option has been selected (see Section 2.6).  By selecting the relevant button 
the map will be displayed as if being viewed from a lesser or greater angle: 
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3.2.6.4 Google 3D Controls 
 
3.2.6.4.1 Map Orientation 
 
The ‘N’ at the top of the compass circle can be dragged around the circle and 
the orientation of the map view will move with it. It will therefore indicate the 
direction of North. If it is clicked once it will reorient the view with North at the 
top. 
 
3.2.6.4.2 Panning and Zooming 
 
The arrowheads will pan the view when clicked. Therefore if the upward pointing 
arrowhead is clicked then the view will move as if looking upwards etc. The point 
that the view is taken from will remain static. This gives a similar view to the tilt 
controls explained above. 
 
When clicked, the arrowheads in the lower circle will change the location of the viewing 
point in the direction of that arrow. 
 
The zoom control in 3D mode works in a similar way to the 2D version. 
 

3.2.6.5 Microsoft Views  
 
There are three ways to view the Microsoft map; Road, Aerial, and Birds Eye.  
 

 
Note: 
The ‘Aerial’ and ‘Bird’s Eye’ options are dependent on image coverage  
and are not always available at certain zoom levels. 
 

 

 
 
Road:                 Aerial:     Birds Eye:   

         
                          
3.2.6.5.1 Labels 
 
Selecting the ‘Labels’ option will show or remove the Road/Landmark names in the Aerial and 
Bird’s Eye views. This information is always displayed in the Road view. 



SkyTrac Systems Ltd. 

SkyWeb User Guide v 03.20 (DOC1838)  Page 22 of 79 

Restricted Proprietary and Confidential Information 

3.2.6.6 Google Views 
 
There are several different options to view the Google maps:  
  

 
 
Map, Terrain and Satellite (with or without labels) options are standard features in SkyWeb. 
 
Map:       Terrain: 
 

    
 
 Satellite (with labels)    Satellite (without labels): 
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Value-added mapping features include Aeronautical charts:  VFR and IFR maps (High 
Altitude and Low Altitude.)   
 
Contact your Program Manager to enable these features for your maps. 
 
VFR       High Altitude 

    
 
Low Altitude 
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3.2.7 Overview Map 
 
This option provides the user with an overview of the area of the 
map that they are currently looking at. This is particularly useful 
if they are currently zoomed in to a specific area but also wish 
to see where they are in overall terms. It can also be used to 
navigate the map. By clicking on the rectangle and dragging it 
with the mouse the main map can be shifted to the relevant area 
of interest. 
 
 
 

3.2.8 Aeronautical Charts 
 
Displays the VFR, HI and LO options in the 
menu bar, to access the current aeronautical 
charts on the map.  Only users that have been allocated this role by the Program Manager 
will be able to view these maps.   
 
Note, this feature is only enabled for Google Maps.  Microsoft Maps is not supported at this 
time. 
 
 
 

3.2.9 Sidebar 
 
If this option is selected the 
Sidebar will be visible on the 
left hand side of the screen. 
The Sidebar contains the 
settings for Weather, Terrain 
and Obstacle Data and 
NOTAMS.   
 
Only those users that have 
been allocated these roles by 
the Program Manager will be 
able to configure it. 
 
See Section 3.7 for complete 
instructions of the features 
available in the Sidebar. 
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3.2.10 Weather Legends 
 
Displays the legend outlining the various weather features. 
 
 

3.2.11 Reporting Regions 
 
Reporting Regions are used to designate regions on the map that assets are operating in.  
They are used to generate reports based on asset movements inside different regions and 
keep them separate from other assets. 
 
If checked, any Reporting Regions created in the Administration page will be displayed on the 
map.  Data for assets in these regions is available on the Reports section of SkyWeb. 
 
 

3.2.12 High Resolution Data (ISAT 200A Only) 
 
High Resolution Data is a value-added service.  It is enabled on a per user account basis by 
your Program Manager in the Account Management section of SkyWeb. 
 
If this option is selected then the High Resolution Data will be visible on the map and in the 
Log data.  
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3.3 Aircraft Menu 
 
The Aircraft menu provides a means to follow specific resources and add additional 
information to the map such as flight paths and event locations. 
 
 

Menu Sub-Menu Remarks 

Show All 
All  resources (from the data originally loaded) will be 
displayed 

 None Hides all aircraft from the map and flight bar 
 Selected Corresponds with the ‘Select’ Option below 

 Select... 
The user selects the required aircraft from the ‘Show 
Aircraft’ dialog box (see below) 

   
 On-Ground Only show resources powered up but not in the air 
 In-Flight Only show resources in the air 
 Powered-Up Show resources power up in any state of flight 
 Powered-Down Only show resources that are not powered up 
   

Frame All 
All  resources (from the data originally loaded) will be 
displayed 

 Selected Only resources set in the ‘Select’ Option below 

 Select... 
The user selects the required aircraft from the ‘Frame 
Aircraft’ dialog box (see below) 

   
Paths All Show flight paths for all resources originally loaded 
 None Do not display any flight paths 
 Selected Only resources set in the ‘Select’ Option below 

 Select... 
The user selects the required aircraft from the ‘Aircraft 
Flight Paths’ dialog box (see below) 
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3.3.1 Show 

 
The Show Menu corresponds to the information in the FlightBar at the bottom of the screen.  
 

 
 
If the user chooses the ‘Select ...’ option the ‘Show Aircraft’ dialog box will appear. From this 
box the user can select the resource(s) they would like to see. They can either select a single 
option from the ‘Show’ area or select specific aircraft in the ‘Resources’ area.   
 

 
 
The user also has the option to include those aircraft that are currently not displayed on their 
screen in logs and also show aircraft that are not within the current time frame. 
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3.3.2 Frame 
 

 
 
Framing will automatically center the map on the chosen resource(s) for a single instance. 
The user can frame the current location, the start location, or the entire flight path, as well as 
limit the frame based on the resources’ state (e.g. In-Flight).  
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3.3.3 Paths 
 

 
 
Paths will show or hide the flight paths of the chosen resource(s) and can also have Events 
(e.g. Voice call or Power Up/Down) and arrows shown. 
 

 
 
 

 
Note:  Adding paths, events and arrows all use the computer’s resources and could  
slow the display performance when applied to a larger number of resources. 
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3.4 Tools Menu 
 

 
 
 

3.4.1 Destination… 
 
This will show the projected flight path from the selected aircraft to a point clicked on the map. 
In the Destination dialogue box the user can select the required aircraft. They can then either 
click ‘Edit’ to enter the details of a destination (name, location and radius of the destination 
circle) and specify an ETA, or they can click ‘Select’ to choose one from the geo-reference 
list. If they have previously set a destination/ETA they can either select ‘Clear’ to remove it or 
use ‘Edit’ to change the details. 
  

 
 
If the ‘Edit’ option is selected - the user can right-click on the map to set the destination 
location. They also have the option to name the destination location. Now that a destination 
has been set the information will be available to be included in the FlightBar and the ETA will 
be relevant to the destination. These options are not available in 3D mode.  
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3.4.1.1 ETA 
 
When the user sets a destination, the ETA column will have a time and countdown in it based 
on the current speed and distance the aircraft is from the destination. The user also has the 
option to enter a specific estimated time of arrival. If the aircraft is not in the destination area 
(the circular area defined by the radius) at the specified time they can be warned by a pop-
up, and/or audible alarm. They can also configure a list of email addresses that are to be 
warned when this occurs. The ETA email notification list is entered in the Administration 
section of SkyWeb and covered in the Administrator’s Guide. 
 

 
 
When the user has the Destination box on the screen they can either use the Select button 
to select a geographic point as the destination or they can select the Edit button to enter their 
own location: 
 

 
 
Right-clicking on the map will set the destination as a Lat and Long. The user can then give 
it a name. They can set the ETA using the calendar and time field. They can also now set the 
radius for a circle encompassing the destination location. It is this area that the aircraft must 
be in at the set time. If it is not - the alarms (if they have been configured) will be generated.   
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3.4.2 Pinned Reference 
 
Normally the reference displayed/used in the logs for any particular asset is the reference 
closest to it. As the asset moves closer to the next reference - the reference in the logs will 
then change to again show that which is closest to it. 
 
A pinned reference is a reference that remains ‘tied’ to an asset until the user decides to clear 
it. 
 
The reference used can be either: 
 

 A Georeference 
 Another Asset 
 A Marker 

 
As long as the markers & Georeferences have previously been set-up in SkyWeb then either 
these or a unit/asset can be selected. The procedure is as follows: 
 
Select the ‘Pinned Reference’ option from either the Right-Click or Tools menu. 
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3.4.2.1 Geo Reference Chooser 
 
From the list of assets displayed - select the asset to set the 
pinned reference for. Then select the type of pinned reference 
(GeoRef / Asset / Marker). The user will be presented with a list 
to choose from. In this example the user has selected to use a 
Geo Reference. Selecting the required reference will then pin it 
for the previously selected asset/unit. 
 
 
 
 
 
 
 
 
This reference will now appear in the log as a pinned reference: 
 

 
 
Also, selecting Tools>Pinned Reference will show this reference against the unit/asset: 
 

 
 
 

3.4.2.2 Clearing Pinned References 
 
This can either be achieved by selecting the unit and 
then the ‘Clear Pinned Reference’ option from the 
right-click menu, or by selecting Tools>Pinned 
Reference then the relevant unit in the list followed by 
the ‘Clear’ button. 
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3.4.3 Calculate Distance 
 
By selecting this option and then right-clicking on locations on the map – a line will be drawn 
on the map for each leg of the calculation.  The total distance will be calculated and displayed 
in a box at the bottom of the map. This option is not available in 3D mode. 
 

 
 
Each of the legs will be calculated separately and displayed on the map (as shown above). 
At the base of the map the following box will be displayed: 
 

 
 
It includes the total distance calculation. If the user then hovers the mouse over one of the 
dots on the line – additional options will appear: 
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3.4.3.1 Right-Click to Move Location 
 
If the user Right Clicks on one of the points along the line and at the same time drags the 
mouse then the point will move with it. This will then relocate that leg of the distance 
calculation. 
 

 
 

3.4.3.2 Shift + Right-Click to Insert Location  
 
If the user hovers the mouse over one of the points on the line and then uses the Shift+Right-
Click combination whilst dragging the mouse, a new point will be created that will move with 
the mouse until the right-click button is released. 
 

3.4.3.3 Ctrl + Right-Click to Delete Location  
 
If the user hovers the mouse over one of the points and then uses this combination the point 
will be deleted. 
 
 

3.4.4 Go To... 
 
Selecting this option will cause a list of the user’s custom geographic reference points to be 
displayed. The user can then select the relevant point and the map will automatically move to 
it. 
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3.4.5 Geofences… 
 
A Geofence is an area that can be marked on the map and have alerts and notifications 
generated if an aircraft enters or leaves it. 
 

 
 
If any previous geofences had been created they would be listed here. To add a geofence the 
user selects the ‘Add a record’ option. 
 

 
 
The user enters a Geofence label by which to identify it. They must then decide whether the 
geofence is to be a circle or a polygon and select the relevant radio button. If it is to be a circle 
then it will require the user to enter a radius for the circle. Right-clicking on the map will then 
cause the center of the circle to be placed at that location. 
 
If it is to be a polygon then each right-click on the map will locate a point for the polygon (see 
above image). The user can specify whether the geofence is currently ‘Active’ or not and 
whether the restriction on it is to be when a unit enters or exits the geofence. 
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Selecting OK will add the geofence to the list and also (if it is active) display it on the flight 
following map. When a resource violates a Geofence, its caption, and also the position 
information in the FlightBar will be highlighted in a bright yellow.  
 

 
 
An audible and visual alarm can also be displayed (if required). These are configured in the 
Preferences Menu. 
 
 

3.4.6 Georeferences... 
 
This section allows for the addition of custom reference points onto the map. This can include 
points that may not be on a standard map such as helipads, oil platforms, hospitals, runways, 
etc. These points will be shown in the Flight Bar's Position column as a relative position to the 
aircrafts location (i.e. 4.3nm SE Vancouver Intl). 
 
All reference points that are added will be seen by all accounts created under the company 
name. The user selects ‘Geographic References’ from the column on the left side of the 
Administration page. To add a new point the user must click ‘Add a Record’.  
 

 
 
To remove a reference point, the user must select the entry from the list and click ‘Delete’.  
 
To edit an existing reference point, they must double-click on the entry and make the 
appropriate changes. 
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Enter the appropriate information about the reference point: 
 

Field Remarks 
Name How the reference point is to be labelled 
Ident The short name of the reference point (if required) 
Region Geographical area (e.g. State, Province or Country) 

Display on Map 
Reference point names will automatically show in the Flight Bar 
Users have the option to show the created point graphically on the 
map as well 

Show at scale 
Select the zoom level at which the reference point is to appear on 
the map 

Type Select the icon that will represent the reference point on the map 

Latitude/Longitude 
These values can be typed in directly or users can right-click on the 
map to add the latitude and longitude values automatically 

 
Once all of the information has been entered the user must click ‘OK’ to save the changes. 
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3.4.7 Silence Alarms 
 
The user has the option to silence the alarms for each of the alarm types or they can choose 
to silence them all. 
 

 
 
 

3.4.8 Poll Now 
 
This will force the software to instantly poll the SkyTrac network for any outstanding reports 
or messages without having to wait for the next poll interval.  
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3.5 Preferences Menu 
 

 
 

3.5.1 Alarms... 
 
The Alarms Menu has the following options  
 

Options Remarks 

Audio Alarm 
Enables audio 
notification for 
relevant event 

Popup Alarm 

Enables a visual 
notification for 
relevant event in the 
form of a window 
popup 

Sound 
User selected sound 
for the relevant event

 
The alarms can be selected and deselected as required. The alarms can also be managed 
from the Right-Click menu (Section 0) when the relevant aircraft has been selected.  
 

Important:  The user will only receive Overdue alarms for those units that have been  
configured to receive them (in the Administration Section of SkyWeb) 

 
ISAT Emergency has the additional option of ‘Require Acknowledgement’. Selecting this will 
mean that the pop-up message in SkyWeb cannot be closed without a message being sent 
to the unit first. 
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3.5.2 Aircraft... 
 
The user can select how they wish to view their aircraft information on the screen. There are 
options to change the type of aircraft icon and whether captions or status previews are 
displayed (and if so how much information they should include). 
 

3.5.2.1 Icon Tab 
 
Changes the way the aircraft icon is displayed.  The transparency of the icon and the halo 
can be adjusted. 
 

      
 
 
Options Remarks 
Size:  Varies the size of the icons in SkyWeb 

 
Small/Medium/Large/
Very Large/Huge 

Relative size of the icon, regardless of zoom level. 

 Automatic 
The size will vary as the user changes the zoom 
level 

Encircle  
The resource icon is surrounded by a circle to 
increase visibility on the map 

Draw  line  to  nearest Georeference
Sets the transparency of the icon and the colour halo 
around it. 
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3.5.2.2 Caption Tab 
 
The caption is an information box that follows the aircraft and is visible at all times unless 
specifically hidden.  The transparency of the box can be adjusted.  Remove the check mark 
from the Show box to hide the options and also hide the caption on the map.  Click ‘Apply’ to 
make the change. 
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3.5.2.3 Hover Tab 
 
When the mouse is paused over an icon or caption text will be displayed.  Remove the check 
mark from the Show box to hide the hover text on the map.  Click ‘Apply’ to make the change. 
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3.5.2.4 Click Tab 
 
Displays a popup window with user selectable flight information.  Remove the check mark 
from the Show box to hide the options and also prevent the popup window from appearing on 
the map.  Click ‘Apply’ to make the change.   
 
The window will automatically close when another position report comes in or the user clicks 
somewhere else. 
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3.5.3 Geofences... 
 
The user can set the preferences they require for the Geofences. 
 

3.5.3.1 General 
 
Set the transparency of the geofences.  Remove the check mark from the Show box to hide 
the options and also hide the geofence on the map.  Click ‘Apply’ to make the change. 
 

 
 

3.5.3.2 Hover 
 
Select the fields to display when the mouse is hovered over any part of the geofences. 
Remove the check mark from the Show box to hide the options and also hide the text on the 
map.  Click ‘Apply’ to make the change. 
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3.5.3.3 Click 
 
Set the preferences for information displayed in the popup window when the geofence is 
clicked.   
 
Remove the check mark from the Show box to hide the options and also prevent the popup 
window from appearing on the map.  Click ‘Apply’ to make the change. 
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3.5.4 Geo References... 
 
The user can set the preferences they require for the Geo References: 
 

 
 
The geo reference points that the user has added (Custom Points) can be displayed on the 
map if required. The user can also select whether they wish to use those custom points as 
the points that are referenced in the position logs rather than the predefined points provided 
by SkyTrac. 
 
The size of the icons can be changed and the zoom level at which the names show.  The 
transparency can be adjusted here as well.  Remove the check mark from the Show box to 
hide the options and also hide the geo references on the map.  Click ‘Apply’ to make the 
change. 
 
 

3.5.5 Rendezvous... 
 
If the user’s resource group was designated as a Rendezvous Group by the Program 
Manager in Account Management, then they will have access to this option. 
 
A popup window appears where the user can select settings for how Rendezvous data are 
displayed on the map. 
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If Show All or Hide Vectors are selected a red line will 
appear on the map indicating the Rendezvous 
location.  If Hide is selected none of this will appear. 
 
 
 
 
 
 
 

 
 

 
 
 
 

Display Remarks 
Hide Hides all data 

Hide Vectors 
Draws vector lines 
from each point 

Show All 
Displays all vectors 
and graphics 

Important:  Rendezvous is only available on ISAT-200R Cat M units (Mod C) 
running mainboard firmware 1.x or higher and CDP-300 firmware 5.x. 
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3.5.6 Zoom... 
 
The ‘Zoom Limit’ option sets the level of zoom that will be applied when the aircraft is selected 
from the FlightBar. If the user selects the ‘Restore’ option, the limit will be used whenever the 
user opens SkyWeb. However they must select the ‘Save Settings’ option in the file menu 
when they have checked this box.  
 

 
 
 
 

3.5.7 GPS Display Options... 
 
The user can change the Units that are displayed in SkyWeb. 
 
 

 

Unit Remarks 
Co-ordinates 
Deg Degrees 
Deg:Min Degrees:Minutes 
Deg:Min:Sec Degrees:Minutes:Seconds
Time 

UTC 
Coordinated Universal 
Time 

Local Local to the current user 
Speed 
km/h Kilometres per hour 
Mph Miles per Hour 
Kts Knots 
Distance 
nm Nautical miles 
m Metres 
km Kilometres 
mi Miles 
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3.5.8 Data 

 
This option is only available to the Full Access User. They can select how much data they 
wish to see by specifying the number of previous flights or days. Both of these options are 
limited to a maximum of 4 (either the previous 4 days or 4 flights). 
 

 
 
 
 

3.5.9 Poll Interval 
 
The interval at which the data is polled from the SkyWeb servers can be selected from the 
sub-menu. If the ‘Stop’ option is selected the data will not be polled until it is reselected again. 
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3.5.10 Configure FlightBar 
 
This option is only available to the Full Access User. It gives them the ability to customize the 
information displayed in the FlightBar tabs at the bottom of the window (Status, Flight, Log 
and Event).  For example, selecting Preferences >Configure FlightBar> Status will cause the 
Status Log dialog box to be displayed. In this box the user can specify which columns they 
wish to see in the “Status Tab” of the FlightBar.   
  

 
 

3.5.10.1 Add or Remove Columns 
 

 
 
To add or remove a column it must be selected in the ‘Available’ area and then click either 

 (add) or  (remove) to place it in the ‘Selected’ area.  Only those columns that are in 
the ‘Selected’ area will be displayed in the relevant tab of the FlightBar. To add or remove a 

group of columns use the  (group add) and   (group remove) buttons.  
 
The same procedure can then be used for modifying the other tabs in the FlightBar. See 
Section 0 for a detailed description of the FlightBar. Some of the available columns will only 
show data if the aircraft is installed with an ISAT-200. These options are also available by 
right-clicking on the column headings in the FlightBar. 
 
Below is a table of column headings that may appear in one or more of the Flight Bar tabs. 
 

Title Remarks Title Remarks 

Unit Unit Serial Number Path (Colour) Path Colour as per the map 
ISAT  Event (Icon) Event icon 
IMEI # IMEI Number Time Time 
Reg # Registration Number Latitude Lat 
Flight # Flight Number Longitude Long 
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Type Event Code Number Position 
Position in relation to georef 
point 

Latency 
Delay in data reaching 
Iridium 

Altitude Alt 

MOMSN 
Mobile Originated 
Message Sequence 
Number for debugging 

Track Direction of travel in degrees 

PktIndex Packet Index number Speed Speed 
AFF Is the Unit on AFF Event Event that occurred 

FlightWatch Indicates deviations Extra 
Phone number dialled and 
duration 

GPS Signal Validity of GPS Signal Geofence 
Indicates Geofence 
violations  

Sequence Packet sequence number Air Up/Down Time of wheels event 

HDOP 
Horizontal Dilution of 
Precision 

Air Time Time in the air 

VDOP 
Vertical Dilution of 
Precision 

  

GPS 
Precision 

Figures for both HDOP 
and VDOP. Smaller figure 
indicates better precision 
from GPS Sat geometry  

Flight Time Time powered up 

Modem 
Signal 

Quality of signal indication Position/Origin  

Mission 
Active 

Time mission active Position Dest  

Mission 
Flight 

Time powered up in 
mission 

Selector  

Mission Air Time in air in mission CallSign CallSign for unit 
Mission 
Distance 

Distance travelled in 
mission 

ETA Estimated Time of Arrival 

Mission # Optional number Destination  
Expand/Coll
apse 

Icon Air Up (Icon) Icon 

Show/Hide 
Path 

Check box Air Up Date and Time 

Start On 
(Icon) 

Icon Air Down (Icon) Icon 

Start/On Date and Time Air Down Date and Time 
End/Off 
(Icon) 

Icon Start Position Distance to reference point 

End/Off Date and Time End Position Distance to reference point 
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3.5.11 Display Seconds in Log 
 
Shows or hides seconds in the flight log.  Some units may be set for seconds resolution and 
others not, this will allow columns to line up consistently.   
 
 
 
3.6 Help Menu 
 

 
 
The Help menu provides a link to this SkyWeb user manual from our website and a link to the 
About SkyWeb dialogue box which contains the SkyWeb version and SkyTrac Systems 
contact information. 
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3.7 Sidebar 
 
The Sidebar contains extra map data that can be overlaid on the main Flight Following map. 
 
These options are all value-added services.  They are enabled on a per user account basis 
by your Program Manager in the Account Management section of SkyWeb. 
 

 
 
 

3.7.1 Weather 
 
The Weather overlays provide visual updates to weather conditions in the areas where aircraft 
may be flying. 
 

3.7.1.1 Animation 
 
At the top of the bar are two sliders. These control either the time between successive 
animations (Dwell), or the Speed of the weather playback. 
 
The playback controls are directly below the 
sliders and are used to play through the 
animation of the weather conditions. The 
animation can only be used with a single 
layer. If an animation is being played and the 
user selects another layer it will stop. 
 
The user may have to wait until the sequence has loaded before it can then be played through. 
This will be indicated by a buffering number next to the selected 
layer. 
 
The available weather layers are on the left. Clicking on the  will open the list of weather 
layers for that geographic area. Not all of these geographic areas may be available to the 
user. Contact your Program Manager to add the additional areas as required. 
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3.7.1.2 Layers 
 
Individual layers can now be selected as required. Each of these layers has slider controls for 
Opacity and Layering (where in the layers they should sit). These controls are displayed when 
the user clicks on the text of the layer. Note: Adding too many layers may cause the computer 
to slow down. 
 
If the user hovers the mouse over the title of a layer it will cause a legend to be displayed 
(briefly) for that particular layer. If the user wishes to see a Legend permanently then they 
must select it from the ‘View’ menu. Then as a layer is selected, the key information reference 
the icons used will be added to the ‘Legend’ see below. 
 

 
 

 

3.7.1.3 Legend 
 
If the weather option has been enabled then selection 
of this option will show the Legend containing details 
for the currently selected layers: 
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3.7.2 Terrain and Obstacle Data 
 
This is a value-added service.  It is enabled on a per user account basis by your Program 
Manager in the Account Management section of SkyWeb. 
 
Terrain and Obstacle Data (TOD) describes all known obstacles of interest to aviation users 
in the United States, with limited coverage of the Pacific, the Caribbean, Canada, and Mexico. 
 

3.7.2.1 Obstacles 
 
Select the types of obstacles to be displayed on the map.   
 

 
 
Under the Filter header, place a check in the Show Verified Only box to show only verified 
obstacles on the map, all unverified obstacles will be hidden. 
 
Slide the Zoom bar to set the zoom level at which the icons will appear on the map.  If there 
are too many obstacle types selected and the map is too cluttered with them, either reduce 
the number of obstacle types selected, move the slider closer to the + symbol and zoom in 
closer to the ground. 
 
The default max setting is Level 9, approximately 1 : 900,000. 



SkyTrac Systems Ltd. 

SkyWeb User Guide v 03.20 (DOC1838)  Page 57 of 79 

Restricted Proprietary and Confidential Information 

 
Hover the mouse cursor over any obstacle icon and a message will popup displaying the 
obstacle type. 
 

 
 
 
Click the icon and another larger message with more details regarding the obstacle will be 
displayed.  
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3.7.2.2 Types of Obstacles 
 
Below is a table describing a few of the type of obstacles that may be displayed on the map. 
 

Obstacle Icon Remarks 

Bridge 
 

Bridge 

Building 
 

Building greater than 1000 feet AGL 

Building 
 

Building less than 1000 feet AGL 

Catenary 
 

Power line or suspension cable bridge 

Pole 
 

Pole (Flag, Light) 

Stack 
 

Stack (Smoke, Industrial) 

Tower 
 

Building with Tower greater than 1000 feet AGL 

Tower 
 

Building with Tower less than 1000 feet AGL 

Tower 
 

Transmission Line Tower, Telephone Pole 

Tank 
 

Tank (Water, Fuel) 

Windmill 
 

Windmill (Wind Turbine) 
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3.7.3 NOTAMs 
 
Notice to Airmen (NOTAMs) is a value-added 
service.  It is enabled on a per account basis by 
your Program Manager in the Account 
Management section of SkyWeb. 
 
The Filter heading can be used to filter the 
NOTAMs by radius around all assets, specific 
assets, or an ICAO designation ID. 
 
Notices may also be filtered by the age of the 
NOTAM in days. 
 
As new notices arrive in real time a counter icon 
will increment with the number of un-read notices 
and the notice will be highlighted in yellow. 
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When the mouse is moved over each new NOTAM the Yellow background highlight will turn 

Light Blue and the  icon will appear at the location of that particular NOTAM, with a dotted 
line around it at the radius specified..   
 
 

 
  



SkyTrac Systems Ltd. 

SkyWeb User Guide v 03.20 (DOC1838)  Page 61 of 79 

Restricted Proprietary and Confidential Information 

4 FLIGHTBAR 

 
The FlightBar shows flight information for all of the resources that have been assigned to the 
user account. It can be resized by holding the mouse over the top line of the FlightBar, clicking 
once, then holding the mouse button down and dragging the line up or down.  
 
The appearance of the FlightBar will vary depending on the user’s designated role. For 
example; Full Access Users will see the tabs (Status, Flights & Log) along the bottom, Basic 
Access users will not. They will see the information as it is shown for the Status Tab. 
 
The user can also change which columns appear in each of the tabs (see Section 0) 
 
 
4.1 Status Tab 
 
The ‘Status’ tab shows the current status of all resources that have been assigned to the user. 
The resources that have the most recent events will be at the top of the list. Clicking on an 
aircraft entry here will cause the map to be centered on that aircraft. Clicking on a column 
heading will cause the list to be sorted by that heading. The column that is currently being 
used as the sort column will have a small arrow next to it:   clicking it again will 
reverse the order. 
 

 
 
The columns displayed here can be changed by the user if required. This is achieved via the 
Preferences > Configure FlightBar> Status Log option (see Section 0) 
 
Alternatively the user can right click on a column heading to get the ‘Customize Tab’ option 
 

 
 
Selection of this option will display a list of currently selected column headings (on the right) 
and a list of those still available to add (on the left). 
 
Click ‘Remove This Column’ to instantly remove the selected column without having to open 
the  Customize Status Tab window. 
 
Addition/removal is achieved by selecting the required column heading in the relevant window 
and then clicking the relevant centre arrow buttons. The user can then place the column in 
the correct location using the up or down arrows at the bottom of the right window. 
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4.2 Flight Tab 
 
This area displays the data for each flight. The user 
selects the required aircraft on the left of the FlightBar in 
the Assets section and the flights will be listed on the 
right.  
 
 
 
 
 

Clicking the options in the top right corner    will 
enable the user to either sort the assets (using the arrow), display more or less information 
(by use of the menu icon) or close the assets box to the left. 
 
The additional information that can be displayed is the number of flights and positions. These 
will be in parenthesis after the unit. 
 
The actual number of flights displayed will depend on the option that has been selected in the 
Preferences menu i.e. ‘Last 4 Flights’, ‘Last 2 Days’ etc.  
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Additional details for the required flight can be seen by clicking the  next to it. Clicking on 
an entry here will cause the map to be centered on that location. 
 

 Start/On and End/Off indicate a flight. 
 The Air/Up and Air/Down are the flight legs of that flight. 
 Pos/Origin is the position or the resource relative to the beginning of the flight leg. 

 
 
Note:   
If Wheels events are not enabled for resources,  
the flights and flight legs are treated as one unit. 
 

 
 
 
4.3 Log Tab 
 
More detailed information is displayed under the ‘Log’ tab. Each flight is listed for the selected 
aircraft. Clicking on the + next to the required flight will cause all of the position reports to be 
displayed along with any additional information. 
 
Clicking on any of the positions listed will cause the map to be centered on that location.  
 

 
 

The user can sort the list by clicking on the  icon in the column heading 
 

If any assets are using Encryption, then each position will also have a  padlock symbol on 
each line in the flight log. 
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4.3.1 High Resolution Data (ISAT 200A only) 
 
This feature allows ISAT-200A units to display extra position data in between each regular 
position.  E.g. If a unit is currently set for 1 minute reporting, selecting High Resolution Data 
will cause the ISAT to display additional position data for every second in between the regular 
intervals.  This will allow for much greater accuracy in calculating distance travelled. 
 

 
 
The log will show a  on each line in the log if High Res Data is available for that position, 
clicking the  will open an extra window with all of the extra data between this position and 
the next.  On the map the positions will also display the data with each single point 
represented. 
 
Below are the same two positions, one with the High Res Data displayed, which is a much 
more accurate display of the flight path the aircraft actually took.  The second figure is the 
flight path with a straight line between the two points generated one minute apart. 
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4.4 Right-Click Menu 
 
A number of the menu options already discussed are also 
available via the right-click speed menu. The menu will 
appear if the user right-clicks on either: 
 
 

 The aircraft callsign in the Status Tab                                         
 The icon for the aircraft 
 The caption alongside the aircraft 
 The callsign in the Assets list 

 
 
 
 
 
 
 
 
 
 
 
Options Remarks 
Show Status Show / hide the full status information for this resource 

Follow Me 
After each poll where new data is received SkyWeb will 
center the map on this resource 

Create FlightWatch Allows the user to start creating a FlightWatch 

Edit FlightWatch 
Allows the user to make changes to the current 
FlightWatch 

Delete FlightWatch Allows the user to delete the current FlightWatch 
Show Flight Path Show / hide the flight path of this resource 

Show Caption 
Enable / disable the mouse over caption information for 
this resource  

Bring To Front 
Brings this resource to the top of a stack of resources, 
allowing for easier interaction 

Set Current Mission # 
Allows the entry of information (e.g. contract number or 
patient number) that will be tagged to this flight 

Set Next Mission # Set details for the next Mission 

Set Destination... 
Set the destination and ETA for this resource (see Section 
3.4.1) 

Clear Destination Removes the destination for this resource 
Set Pinned Reference Allows each unit selected to use a single point of reference
Clear Pinned Reference Clears the above reference 

Edit Note... 
Selection of this option allows the user to add a note that 
will appear in the caption (when displayed)  
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Options Remarks 
*Initiate Cooperative 
Rendezvous 

Starts the cooperative rendezvous procedure 

*Cancel Rendezvous Cancels the coop rendezvous for selected unit 

Send Message... 
Allows a quick message to be sent to this resource (seen 
by users with full Flight Following Access only) 

Current Alarms... 
Enable / disable alarms for this resource. This only affects 
audio alarms within SkyWeb (Section 3.5.1) 

 
*  only seen by users that have the Rendezvous enabled (see section 3.5.5). 
 
 
 
4.5 Create FlightWatch 
 

 
Important Note: 
 The FlightWatch parameters that are entered into SkyWeb are designed to notify the 
SkyWeb user if the unit deviates from SkyWeb user predetermined values.  
The FlightWatch will be visible by ALL SkyWeb users in a company. 
 

 
Selection of this option allows the user to create a FlightWatch. A FlightWatch is a path which 
will alarm if the aircraft strays out of it. The user sets allowable tolerances for how far the 
aircraft can stray from the center line and also the designated destination point. They can also 
set a minimum and maximum GPS altitude, which will also cause an alarm if the unit breaks 
these tolerances (i.e. by going above the maximum or below the minimum).  
 

 
 
Once the relevant details have been entered, the FlightWatch will start at the current location 
of the unit. The user can then right-click on the map to place each waypoint that they wish to 
use for the FlightWatch and it will be drawn on the map between the points. 
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If the user hovers the mouse over a point, that point will change colour and additional options 
such as ‘Right-Click and Drag to Move Waypoint’ will be displayed. In this way the user can 
edit the location of the waypoints as they are positioning them. 
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The example below shows a FlightWatch being used to provide a SkyWeb user a warning 
path for a unit that has to fly around a Geofence. If the unit leaves the FlightWatch, SkyWeb 
will alarm: 
 

 
 
The alarms can be both audible and visual. The visual ‘pop-up’ allows the user to send a 
message to the unit and silence the alarm (for this violation) at the same time. 
 
 
 
4.6 Edit FlightWatch 
 
If the user has created a FlightWatch, selection of this option will allow them to edit it (as 
already discussed). 
 
 
 
4.7 Set Current/Next Mission # 
 
The user can select to set the Mission # and can then be displayed against the data in the 
logs.  
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4.8 Edit Notes... 
 
The user can add notes to the caption that accompanies an aircraft.  The note can be 
displayed with the aircraft on all SkyWeb accounts the company has, or only the current 
account that created the note.  
 
 

 
 
 
The Edit Notes feature must be enabled for each user in the Administration section of 
SkyWeb, under the Global Settings: Flight Following Settings. 
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4.9 Initiate Cooperative Rendezvous... 
 
Rendezvous is new feature designed for assets to be able to rendezvous with each other at 
some location. 
 
There are two types of rendezvous, Following Rendezvous, where one aircraft or vessel is 
set to follow another.  This feature will allow assets that are in the same Rendezvous group 
(and have the relevant hardware and specific firmware loaded) to partake in a rendezvous 
procedure. A point on the map will be selected and the asset(s) will be sent the relevant 
information to allow them to meet at that location.  
 
 

 
 
 
On the map a red arrow line will be drawn from each of the asset’s initial start point to the 
selected RV point. This will allow flight followers to see the progress of the rendezvous 
procedure. 
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Assets will be put into ‘Rendezvous Groups’ by the Program Manager in the Account 
Management section of SkyWeb. These assets (and only these) will then be able to be 
selected by the user for a cooperative rendezvous 
 
Those clients that have ISAT-200s and CDP/DVI-300s (with the relevant firmware) will also 
be able to initiate an RV procedure between two assets from the CDP/DVI itself. This would 
then cause a series of arrows to automatically be displayed in SkyWeb, going from the assets 
to the RV point and at the same time the initiating asset will be sent the relevant information 
(in terms of a bearing and distance) to allow them to meet. 
 
 
 

 
 
  

Important:  Rendezvous is only available on ISAT-200R Cat M units (Mod C) 
running mainboard firmware 1.x or higher and CDP-300 firmware 5.x. 
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4.10 Cancel Rendezvous... 
 
Rendezvous can be cancelled at any time.  The red line will disappear and the CDP in the 
cockpit of the asset will no longer show the RV coordinates. 
 

 
 
 
 
4.11 Send Message... 
 
Users may send an email message to the asset using SkyWeb Mail.  Message will arrive on 
the CDP in the cockpit. 
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4.12 Custom Events 
 
If an additional input has been wired in the aircraft and configured in the Hardware Manager 
for a custom event (such as high oil pressure, engine temperature etc), then when this event 
is triggered it will also cause a pop-up warning and alarm. These work in a similar way to 
those discussed for geo-fence and flightwatch deviations. 
 
Custom events will also be displayed in the FlightBar (like Mains-On currently is) but will have 
an exclamation mark next to them (see below). The actual event title that appears will be 
whatever has been configured for the custom event in the Hardware Manager. 
 

 
 
 
 
4.13 Right-Click Map Menu 
 
If the user right-clicks on the map they will also get a speed menu: 
 

 
 
 
Each of the menu options are explained below: 
 

Menu Option Remarks 
Add Address Marker Adds an Address mark at the point selected 
Add Coordinates Marker Adds a Coordinates Marker at the point selected 
Initiate Cooperative 
Rendezvous... 

Starts the cooperative rendezvous procedure 

Delete All Markers Deletes all current markers 
Reverse Geocode Converts a point on the map to nearest address information 
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4.13.1 Add Address Marker 
 
 

 
 
 

4.13.2 Add Coordinates Marker 
 

 
 
 

4.13.3 Initiate Cooperative Rendezvous... 
 
Brings up the same dialog box as when right-clicking on an asset, to set Rendezvous. 
(See Section 4.9) 
 
 

4.13.4 Delete Marker / All Markers 
 
The right-click speed menu changes slightly when the user selects a marker that has already 
been placed on the map. Now the user has the additional option of deleting the selected 
marker: 
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4.13.5 Reverse Geocode 
 
Selecting the ‘Reverse Geocode’ option will convert a point on the map to the nearest set of 
address data available. This will then be available to copy using the Ctrl + C option. 
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5 SKYMAIL 

SkyWeb allows for text messaging to and from aircraft provided the aircraft has a messaging 
interface installed such as a Dispatch Voice Interface (DVI), Cockpit Display Panel (CDP) or 
mobile device with RDA software. 
 
SkyMail can be accessed by clicking File > SkyMail or by clicking the envelope icon 
in the top right corner of the program. The SkyMail program has three tabs; Inbox, 
Sent Items and Create Message. 
 
 
5.1 Inbox  
 
This shows messages that have been sent from the aircraft. Selecting an item in the top half 
of the Inbox will cause the body of the message to be displayed below.  
 

Heading Remarks 
CallSign Indicates the CallSign that sent the message 

DTE 
Indicates which item of Data Terminal Equipment on the aircraft 
received the message. Some aircraft may have multiple devices 
fitted and each device will have a different DTE number 

Sent Time Time that the message was sent 
Subject The message heading 
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To delete messages from the ‘Inbox’ the user can click on the ’Delete’ button. ‘Select All’ will 
select all of the messages currently displayed.  
 
Changing the setting in the ‘Count’ drop-down menu will change the number of emails 
displayed. The user can select to view emails between certain dates by entering the relevant 
dates into the ‘Filter by Date’ fields using the calendars. 
 
 
5.2 Sent Items 
 
This shows messages sent to the aircraft. It uses the same headings as the Inbox. 
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5.3 Create Message 
 
In order to send a message, the user must go to the Create Message tab, select the 
appropriate aircraft from the column on the left, and type the subject and body of the message 
to be sent. If the message is to be sent to a specific DTE (such as a terminal in the back of 
the aircraft), that can be selected. Only one DTE device can be selected, therefore if the user 
needs to send it to more than one they will have to send each one separately. Click the Send 
button and the message will be sent to the aircraft. 
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